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1. System Overview

Nowadays, as more organizations become increasingly computerized, vast amount of
hardcopy documents must be converted into electronic format in order to fit into
different Document Management System and E-Workflow System.

AVScan is an intelligent scanning and electronic filing solution that leverages Avision’s
market-leading document scanners. AVScan possesses distinct features that convert
and index scanned information into electronic documents for easy storage and fast
retrieval.

System Requirement

- Hardware
Minimum Recommended
CPU Plll 1GHz or above P4 2.4 GHz or above
RAM 256 MB Memory or above 512 MB Memory or above
HardDisk .
Storage 2GB or higher
Display 8MB Video RAM or higher
CD-Rom 4x or higher
SCSI Adapter DMA166 or higher
Scanner ISIS / TWAIN Driver Supported
- Software
Microsoft Windows 2000 Professional
Microsoft Windows 2000 Server
os Microsoft Windows 2003 Server
Microsoft Windows XP Home Edition
Microsoft Windows XP Professional
* Microsoft Windows 98 / ME / NT is NOT supported*
Browser Microsoft Internet Explorer 5.5 or higher
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2. Scan (Image Add-In)

& ]

% avscan E-filing System: Document1
Fle Document Yew Page Tools Special Options Help  Powered by WitoScan

| . b Profiles |5im|:|EX-EW j @ @ C,-g Front| Rear | @ Front| Rear | t‘; Fromt| Rear |
j ﬁl Doc. 1/1 \’| 0' @ IE.TL-:,l 100 - 0 jll_‘!lu—jl IScanner's [GER
1]

o L=l
Q& 4
i M

Post-Processing |

1</ <] Page 172 sl Paget File Size:1 33k bytes

PIC EO2-1 Scanning Interface

2.1 Scanner Configuration

Click “File”> “Select Scanner” to select your connected scanner.

Source Selection x|

Source:
USB - AVISION AVZ220 0.26 Setup |

Cancel |

PIC EO21-1 Scanner Type Selection Interface

Then click “OK”.
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After selected scanner, user should adjust the configuration.

2.2 Adjust DPI, Brightness, Contrast, Paper Size and
Color Mode

4 AvScan E-filing System: Document1 == x|
File Document Yiew Page Tools Special Options Help Powered by YitoScan

Profiles I Simple:x-BYW
|i ’ j ﬁl E.Dn[.
O=EEE

[ <| Page 1/2 > >|| Fage1 File Size:1 33k bytes

PIC EO22-1 Setting Interface

2.2.1 Adjust DPI

i (100 =]

PIC EO221-1 DPI1 Setting Interface
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2.2.2 Adjust Brightness and Contrast

& 3

PIC EO222-1 Brightness and Contrast Setting Interface

2.2.3 Adjust Paper Size

Scanner's Maxim. "I

BS - 158.2x25.7cm -
AS - 14,821, 0cm
A5 - 21.0x14.8cm
A4 - 21,029, 7cm
Leqal - 5.5x14in,
Letter - 8.5x11in.
Cuskom Size P

SCanne

PIC E0223-1 Paper Size Setting Interface

2.2.4 Adjust Color Mode

1. There are 3 color setting modes: Color, Gray and Binary.
2. Click either “Front” or “Rear” for simplex scanning.

3. Click both “Front” and “Rear” for duplex scanning.

-:': I Frn:untl Rear ':;_vﬁ Front | Rear c/ I Front Rear |

PIC EO224-1 Color Setting Interface
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2.3 Scanning Image

After setting up the scanner, we can start scanning image.

=£ A¥scan E-filing System: Document

File Dwocurment Miew Page Tools Spe

@ Profiles | I
_________ _‘-] r-*s] E

Is:ﬁ'zl ml Ell rﬂl
PIC EO23-1 Scanning Interface

-

Click _—_I or <HotKey S Key> Scan the Image.

. ] .
Click I or <HotKey P Key> Stop Scanning.
<IllAttention!!! >

Custom Scan:

1. If select “Custom Size” in page size, click File > Custom Scan Size > Define and
Scan.

¥ A¥Scan E-filing System

File Document View Page Tools Specis]l Optons Help Powered by Vitoscan

Profiles | | simplex-B =l ﬁ 5| &4 Frunt| Rear | @_"j Frunt| Rear
w ] A

e

Sran

HanE

Emzil
Print
Select Scanner
Exit
PIC E0O23-2 Custom Scan Size
2. Click L to scan the image.

3. “Custom Size Scanning” screen will pop up.
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¥ Custom Size Scanning x|
] 21.58 i
0 Lttt Pyl
— Preview:
_ Define Zone
— Reset
— Linit:

— ICentimeter j

— Delete
— v Preview
lmane

Scan

— Exit

PIC E023-3 Custom Size Scanning

4. Click “Preview” button, the document will be scanned and shown as PIC E023-4. Use
mouse cursor to select the area which you would like to scan and crop.
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=:| Cuzstom Size Scanmng

x|

Eresiew

'#‘_.\-L.na

“ITOVA

THE er=Fil ety Eapest

Turning Vast Information Inte ¥ital Assets

Define £Zone

Reset

Lnit:

ICentimeter j

Delete
v Preview

lmage

acan

Exit

PIC EO23-4 Custom Size Scanning

You can also click “Define Zone” to key-in the area size.

5:, Define Zone

Left: Ip.4g Top:
Right: |21 26 Bottom:

8] cancel

1.49

17.449

PIC EO023-5 Custom Size Scanning

5. Click “Scan” button to scan the document. The cropped image will be shown in

scanning interface.
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LE A¥Scan E-filing System: Documentl

_iglx
File Document View Page Tools ESpecial Options Help Powered by Vitoscan

| . b Profiles ||DUD|E><-BW j @@ ,/ Frant| Rear | @ Front| Rear | «‘Iantl Rear

| ] feee || [AFE B Z P Mave [ostoree F]
HE S
CIEN=
=3

Qs
=

Post-Processing |

=

)

3
%
%

DER W/ ITOVA
DEMO VITOVA | PEMO

The e-Fifling Frpest

5
-
{
3

i
I 8
Iy

iEe

%
9|9 e

“Bla/ M

i

I [ 3
| “%:J

Turning Vast (nformation into Vital Assets

—
€
€
3.
5
o
<
a
9
3
-]
E
[+]
=
[+)
3
3
[+ ]
s
)
>
w
w
o
#

I <| Page IIM

Fagel File Size:29k bytes

PIC E023-6 Custom Size Scanning result
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2.4 Image Documents Working Area

4 AvScan E-filing System: Document1 == x|
File Document Yiew Page Tools Special Options Help Powered by YitoScan

|i ’ Profiles ISimD|EX’EW j @
j ﬁl E.Dn[. 1/t °| wl @
e

m
&

f;-; Frnnt| Rear | @ ant| Rear | {z_; FrDmt| Rear |

100 - 0 ﬁ_‘!ID ﬂ IS(annEr's Maxim. ¥

LD

olm

[ <| Page 1/2 > >|| Fage1 File Size:1 33k bytes

PIC EO24-1 Scanning Interface

2.4.1 Pages through Documents

2.4.1.1 Add and Delete Document

Do Domet o fae Dok fpecd Optue e Soerel by aicn

o —

Bli| page vz il Faget Fee Gon 7% tohen

PIC EO2411-1 Add and Delete Document
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Click J to create a new document.

Click El to delete a document. The following message will be shown.

Delete Document |

\?2 Do o really wank ko delete khis dacument?

PIC EO2411-1a Confirm to delete document

Click “Yes” to confirm deletion, or click “No” to cancel.

2.4.1.2 Browse Documents and Pages Key Function

=lix]

S5 Ao Sl S D |
Ov Dromed Yo fape Dok pecd Cptarw fes Pl by Wotcn

I-;ﬂ e oj.ﬂ- - m:plg.m*m-']
o sl

[ ([} )| Doc. 120 Q9

i

o] Page [T L Fie (o 170 e

|_<|ﬂ Page 1/2 M\

PIC EO2412-1 Documents and Pages Key Function

User can use these eight icons to browse between documents and pages. The values
next to the icon show the displayed Documents No. and displayed Pages No. / Total
Documents No. and Total Pages No. respectively.

E.g. (PIC E02412-1) Total 2 Document and the first document is displayed. Total 2
Pages in the first document and the first page is displayed.
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2.4.2 Image Display Function (Viewing)

B [oomet Yew fae Dok Sed Qoterd tey Poweedby Veiscan
IT' protbes | [Emgectin =1 [ G o | maae | 5 pront | mace | @7 Feore | me |
L8] oo n 0| 0| [AF|E[wAGE HMp & Foversrmanz]

EER
a =)o

i [
~ & | = @
Q&= 4

b o] page 1z | Page! Fi Size: 130k tytes

PIC EO242-1 Image Display Functional Icon

Zoom In / Zoom Out <HotKey + Key><HotKey — Key=>.

W Key=> and Fit to Height <HotKey H Key=>.

a_
@@@ Image Display Size. Best Fit <HotKey B Key=>, Fit to Width <HotKey
L+
+

Zoom to Selection.

Magnifier.

=
W Hand Pan. Use it to drag the Image.

m | Pages Displaying Icon. Display 1 / 2 / 4 / 8 pages in the screen.

Click “View” = “Actual Size”, to view the actual size of image base on the degree of dpi.

‘:: AYScan E-filing System: Docomentl
File Docwment | ¥iew Page Tools Zpec

v 1 Image
. | 2 Images
4 Images

8 Images
IE E Zoom to Belection
® (|5 Meender
= Hand Pan
SEE
Zoom In
. ﬁ Zoom Chat
tl Best Fit
——  Fit to Height
Post-Processit  Fitto Width
Actoal Bize
P

PIC EO242-2 View Actual Size
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2.4.3 Image Enhancement Function (Post Scan Processing)

£ arm e st ot SCIE]
Bl Coosmet Yo Page fock Secd (pters teb Powered by Wiodcan

otbes |[omgctn ] [y G ront| e | 5 front| mew | @ Fore| Rew |
FLJ 3] ofijoe- 10| 0 %;ﬂfﬁﬁ{ﬂ_jﬁln_j e ny

Fi
(Ll
—
—

o
Sl

PIC EO243-1 Image Enhancement Functional Buttons
Click Q

| or <HotKey ESC Key=> resets all actions (i.e. cancel selected
function).
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2.4.3.1 Insert Page ﬁ'

Step 1
Step 2

Step 3
Result

2.4.3.2 Rescan Page il

Step 1
Step 2
green.

Step 3
Result

Press

Press

Select the “Insert Page” button.

Click the Insert Destination.

(E.g. Click the Page 5 and insert the Page between Page 4 and 5.)
Click “Scan”.

The Scan files inserted to the destination pages.

W

cancel the insertion.

At
|

Select the “Rescan Page” button.
Click the rescan target page and that page no. will be highlighted with

(E.g. Click the Page 5 and scan. Page 5 will be rescanned.)
Click “Scan”.
The target page will be substituted by a new scanned image.

W

cancel “Rescan’.

2.4.3.3 Delete Page @ \

Step 1
Step 2

Step 3
Result

Press

Select “Delete Page” button.
Click the target pages and those page no. will be highlighted with red.
(E.g. Click the Page 2 and 4 to delete the pages.)

Click button or <Hot Key Space Bar> to confirm deletion.
The selected pages will be deleted.
#l cancel “Delete Page”.

2.4.3.4 Split Document &

Step 1
Step 2
Result

Click the “Split Document” button.
Click the first page of target pages.
The Document is split.

—

Click merges the split document.
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2.4.3.5 Merge Document

Stepl Click the “Merge Document” button. (Document No. should be > 1)
Result : The displayed documents will merge with previous document.
If the first document is displayed, the second document will be merged
after this process.
Repeat this process and the documents will be merged.

— =

Click to split the merged document.

2.4.3.6 Move Page ::“E

Step1l Click “Move Page” button.
Step2 Select the target page, drag and drop to the destination.
If the destination does not display on the screen, press “Page Up” or
“Page Down” to show it.
Result : Target Page will move to the destination.
S|

Press cancel “Move Page”.

2.4.3.7 Rotate Image _’ ‘ @" ¢

Stepl Click the “Rotate Image” button. (Rotate Left, Flip or Rotate Right)
Step2 Select the target page.
Result : Target page will be rotated.

Press #l cancel “Rotate Image”.
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2.4.3.8 Edit Image

Fi Edit Image

[@la| el #] s|&6] x|« mlwwg &[0z o ool =1/ 2 olo|all ]

=l x|

A
PIC E02438-1 Edit Image Interface
@l Zoom In / Zoom Out
El =5l @ Best Fit / Fit to Width / Fit to Height

Zoom to selection

Cut / Copy the selected region to clipboard

Paste the clipboard content to the image

Clear the selected region with the fill color

Undo the previous operation

Crop the selected region

Undo the previous crop operation

Redo the previous crop operation

Rotate the image by numeric value

el lat et [ [x &

Define the selection region

S |1

Pick the color from the image as fill color

G

Hand Pan

AVScan — User Manual
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Move the selection region

o m First Page / Previous Page / Next Page / Last Page

Save the image changes

Pick the fill color

B s

21
Easic: colors:

TR
A
EFTEET NN
Il | O
Ll .}
mEE

I
[
“
[
3
]
o
o
]

Define Cugtam Colors > "

(] I Cancel |

Click EI to save the enhancement and click x| back to scanning interface.
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2.4.3.9 Copy Particular Page (Duplicate From Different
Documents)

3:, Copy Particular Page

SoLurce:

Document: |1

ill Page: Il %l

Diocurment: |1

Destination:

jl Fage: Il ﬂ

PFlrnes smieves aps [FOELR ot dolloorlng. Al gy toms 3¢ sgually wetgind.

L b -flv'\'urll-:lx‘--pl ¥ foc-mes el agariy w e
3

1 Dragea Rirknss bt drippiel all Becing 139 P uad sl ] o oy At
Bt Maacuaa wui ot facion aesd praces of s chorge

= by ol Aaa it e 1 B bty 1 rar beecr,
it ke g e sy gt D

P Suppars oa s s gl (s risid, whai il o cormanr b
a0y Ui W iotiont of U Flomg, Foorg, Inbcraasicon Ajrpact, ared I inssanans b
oty st a5 Scd i, i &a Pasii Bty Dl ood sowbe Cees o paaf bn
e e i) e e o Lo Bk

3 A e compaTy OO CN ORI RETTIECE WAL ganed recaagy i [hg Kig
okt gt tha geovarh ok Bukacetar i Hmg Lo asd Chiom. Dviciss

6. The Horg Gorg, bt bps i o we ol s b phest sdapons in. e werkd. W
us o songernes wsd Figh dabrd? [F you were L imrpaci sand s kil
- 3o bk b dilhe i prckbarae

T

PFlruss smiees aps [FOELR ot dolloorlng. A s toms 314 sually wetgind.

L b i !fn"\'l{rl}-:lxh-pl ¥ foc-aes e @i o e
3

[ TSy we s—— T — 1) P uad el ved U by At
u..w-n Vipcnam wu anw e Cacions aesd prscess o 1 chorge

Tom v by o A it et 1 s # gt I e, bewon,
it ki g e sy dapiaont, s

. Smppan Tea S 5 SR (S Fir e, whn ol e cormar b
a0 Uk 0 otz ol e Elomg. Koorg, Imbcrassiooa Ajrpacs, ared i nestoars b
b wionid aad ity i ks Piaied Bty Dl s e sowben Clees o par af e
i e gl e e o L Bk

3 e compaTy OO O ORI RETTIECE WAL gined rechagy e [hag Kag
kit et tha geovarh o Bk acetar ia Hong Kong asd Chiom. Dvicass

The g Eor b Aigor e o]t e s k. Wi
ngcetcn ol Fig debayc I yoa were Lo -.pu au.-_m whil
1kt b e s ik arar

T e

IR

Locatian:

IE-eﬁ:ure

AR

] Cancel

Step 1:
Step 2:

Step 3:
Step 4:
Step 5:
Result:

PI1C E02439-1

Click “Tools”> “Copy Particular Page”.

Copy Particular Page

n “Source”, key in the document no. and page no. which is being

duplicated.

In “Destination”, key in the document no. and page no.

In “Location”, select “Before” or “After”.

Press “OK” to confirm or “Cancel” to cancel the operation.
The source page is duplicated before/after the destination page.

AVScan — User Manual
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2.4.3.10 Move Particular Page (Move From Different Documents)

% Move Particular Page

SoLurce:

Document: |1

ill Fage: Il ﬁ

Diocurment: |1

Destination:

jl Page: Il ﬂ

PFlrnes smieves aps [FOELR ot dolloorlng. Al gy toms 3¢ sgually wetgind.

o ATl For wifine skl g s s % finc-ase 5
s a8s Fei Saeriy o ey
e e i the s e e bR

1 Dragea Rirknss bt drippiel all Becing 139 P uad sl ] o oy At
Bt Maacuaa wui ot facion aesd praces of s chorge

Tom vt by o A it e 1 s Sl I e, bewor,
it ke g e sy gt D

£ Bmppedn e e 5% gl gy o, i weni |y coramens b

P —— iomg. Ko Inkoraariooa’ Alrpaz, aed bs igessarars b
bt et £ SN iy i 4 Pasti B [l el sowben s m pae al e
e e i) e e o Lo Bk

3 A now compaTy OO O ORI RETVICSE WL apmed recenky i Tlag Keag

okt gt tha geovarh ok Bukacetar i Hmg Lo asd Chiom. Dviciss

6. The Horg Gorg, bt bps i o we ol s b phest sdapons in. e werkd. W

sw . ot o ey wsA T debre® I o woere L mrpas snarapes el
s il o s e s Lt

T

PFlruss smiees aps [FOELR ot dolloorlng. A s toms 314 sually wetgind.

o 0T For wifine skl g e s % finc-ase 5
] ]
e s et che s e e N

1 Dragea Rirkes bt dbippis ol Becing 131 P uad el ved U by At
Bt Maacuan wwi o i facionn sesd praces ol han chorge

Tom v by o A it et 1 s # gt I e, bewon,
it ki g e sy dapiaont, s

P Swpparn Toa S o gl (g Frisid, whei ol e cormanr b
any U6 W ibortiont of U Elomg, Foorg, Imcraaricou Afpact, ared I imssanans b
orbey w4 cd s i s Pasii Bty Dl oed sowhe Chees o paaf be
i e gl e e o L Bk

3 e compaTy OO O ORI RETTIECE WAL gined rechagy e [hag Kag
kit et tha geovarh o Bk acetar ia Hong Kong asd Chiom. Dvicass

>

The By Bor ot srramtirnal g i o o] o ot g . ph wcrkd. Wonas
sw . ot o e wsA Tl debree? I o weere L imrpad sanapes il
s il ot s e s e ke

T e

IR

Locatian:

IE-eﬁ:ure

[

AR

] Cancel

x|

Step 1:
Step 2:
Step 3:
Step 4:
Step 5:
Result:

PIC E024310-1 Move Particular Page

Click “Tools”-> “Move Particular Page”.
In “Source”, key in the document no. and page no. which is being moved.

In “Destination”, key in the document no. and page no.

In “Location”, select “Before” or “After”.

Press “OK” to confirm or “Cancel” to cancel the operation.
The source page is moved before/after the destination page.

AVScan — User Manual
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2.4.3.11 Delete Particular Page

Step 1: Click “Tools”> “Delete Particular Page”.

4 Delete Page x|

Page: |1

[0]4 Cancel |

PIC E024311-1 Delete Particular Page

Step 2: Key in the page no. which is being deleted in PIC E024311-1.
Step 3: Press “OK” to confirm (then PIC E024311-2 will be shown) or “Cancel” to
cancel the operation.

Question X
:‘E) This will delete the document!

OFe You sUred

PIC E024311-2 Confirm deletion of document

Step 4: Click “Yes” to delete the document or “No” to cancel.
Result: The selected page is deleted.
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2.4.4 Change the Image Color

v EBlack and White
& bit Gray
24 bit Color

PIC EO244-1 Change the Image Color Interface

Right Click the image page and select “Image Color™.

2.4.5 View the Image Properties

5: Image Properties ﬂ
Color: Black and Wwhite
¥ Resolution: 200 DPI
Y Resolution: 200 DPI
—Size
Size: A4
Width: 21.1 Centimetar
Height: 29.73 Centimeter
Unit: Centimeter j

PIC EO245-1 Image Properties Interface

Right Click the image page and select “Properties”.
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2.5 Image Scan & Enhancement (Advance Functional
Use)

Advance Function used to configure the Scanning Mode and modify the image more
specific.

2.5.1 Scanning Features Configuration

Program will automatically enhance the image before add to the scanning interface with
the Scanning Mode Configuration.

Pt Vi
=] [ &t oo | o | E prone| o | @) Front | mar |

i | e e e |

¥ <] Page uz 3] Faget File 51 33K bvies

PIC EO251-1 Scanning Mode Selection Interface

Profiles
Click “Options”> “Scanning Features” or press 4| to configure the Scanning
Mode.

In Scanning Profile Configuration Interface, there are “General” and “Color Setting”.

Under “General”, user can adjust “Scanner Settings” and “Document Settings”.
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! Scanning Profile Configuration

ﬂ Profile:

General | Calor Setting I

Qrganize | Renarne |

=10l x|

Add Delete | Reset &l |

Scannina Mode Name Zone

—Scanner Settings
e

T
s

Output Colar:

Rotation —— on ' Off

% i = fa

Fantl Rear | @") Fruntl Rear | c/.l Front = Rear |
Resulutiun:lzDD vlﬁ E.rightness: 7! Confrast:  Auto,

—auto C Ol -
Source: |Aut: matic j LR e on 2
Paper Size: IScanner's faximum j ! @ L
MNormal Aggressive

rwThreshalding —& On  Off
o~ g |
3
B

rBlank Page — On & Off

Maise level |

T

—Relative Crop —~ On

Image Scanning Enhancement

Sefting

|| | »@ r;on  off |

—Document Settings

Selit Documert

& Mo Separation
" Separated by Blank Page

! Barcode

" Ewery paper as OME docurment

Shlit £ Marge images

[ Auto Split Images

Image Scanning Adjustment

Save |

Save and Exit

| Cancel |

PIC EO251-2

Scanning Profile Configuration Interface (1)

Under “Color Setting”, user can adjust “Gamma Correction”, “Color Balance” and “Color

Filter”.

! Scanning Profile Configuration

[E-;?u Profile:

General Color Setting |

—Colar Setting

=10l x|

—Gamma Correction

e

ISimpIex—BW j Crganize | Rename | Add Delets | Reset All I
Color Balance (Color Images)
D@  R(-100 - 100) Front 0= r 0=
-100 - TorT | Rear =
in B = =
EEriTED m 5(-100 - 100% Front 0= Rear 0
B(-100 - 100% Front 0= Rear 0

[ Separate the Front settings with the Rear

—Color Filter (B&W / Gray Images)

Q & Mona
R
G
B
Reset All | Copy Colar Settings to All Profiles |
Save | Save and Exit | Cancel |
PIC E0O251-3 Scanning Profile Configuration Interface (2)
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2.5.1.1 Scanning Mode Name Setting

—=—c

| as | peee | mesetal |

o antl Rear | 4 Fruntl Rear | €| Frort Rear

vThresholding — on © Off
AE e
B Resu\ulmn:lzou | €5 erightness: Djﬁ B contrast: At ’7 (‘ r
/ —— G i rﬁ [
Simplex-B\ j Organize | Rename | Add | Celete Reset All
- - - I Lo Hian L
B uce — 5 |
D settings
- Soiit Documert Split / Merge Images

& Mo Separation
 Separated by Blark Page

" Every paper as ONE docurment

 Earcode.

i - [ Em
O Auto Split Images < a | Oéuto Merge Image g 1
El

Sawe and Exit | cancel |

PIC EO2511-1 Scanning Mode Name Setting Configuration Interface

- Organize : Re-order the profile(s).

- Rename ! Change the Name of Displayed Mode.

- Add ' Add a New Mode.

- Delete ! Delete Displayed Mode.

- Reset All : Reset all the Mode with default setting.

- Save 1 Save the Mode Setting.

- Save & Quit Save the Mode Setting and back to Scanning Interface.

- Cancel 1 Cancel the Mode Setting and back to Scanning Interface.
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2.5.1.2 Image Scanning Enhancement Configuration

o =1olx|
LE?J profile: Ereea rganice | Rename Add Dot | messtal |
_Gereral | coigr cettig |
s Setti
T EELIES p ~vThreshalding — on € off
Output Calar: 2% Front | Rear A Front | Rear ‘| Front  Rear
e 5 [ Rear | @ Front| rear | € e | F r
B Resoution:[200  +[ £+ erightness: 0] A contrast A £l @l
- = (s A
Source: SUtDmatic | - e crup on 7 @ @
(BlarkPage — " On & Off
Paper Size: Scanner's Maximum -2 @ @ » % . "
norrmal Aggressive Moise level
—Rotation — on & off - I:;'( L! — o
(RelatveCrop " on & OF o o
Deskew
H Rl e S L=
= ]
LD Settings
—Scanner Settings
—wThresholding —+ on ¢ oOff

Output Color: .;‘: Front | Rear | fg) Front | Rear | *.I Front  Rear | - -~
Resulutiun:IZDD vlf_} Brightness: 7! Contrast:  Auto, a a
Source: IAummatic j Ao trop £0n ® Cii g % - [%

—Blank Page —" On & Off

Paper Size: IScanner's Maxirmum v « E@ - ?ﬁl g | n

Normal Aggressive Moise level
, e el
Rotation —— on & OfFf I:b_x’ . . _.

—Relative Crop — 0On + Off Loy High
Deskew
"%' C C (] _
) Sefting | ﬂ""a & o  of

PIC EO2512-1 Image Scanning Enhancement Configuration Interface

2.5.1.2.1 Output Color

Output Color: ._r‘f Fru:untl Rear | @ Fru:untl Rear | e.l Front I Rear

PIC EO2512-1a Output Color Configuration Interface

This function is designed for scanning image output mode. According to the Output
Color setting, program will scan the image as color, gray and/or binary mode. The
setting can be simplex (Front / Rear) or duplex (Front & Rear) scanning.

2.5.1.2.2 Resolution

Resolutian: IEEIEI v| |

PIC EO2512-2a Resolution Configuration Interface

According to the Resolution setting, program will scan the images in different degree of

dpi (range from 50-600 dpi).
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2.5.1.2.3 Brightness

{:r Brightness:

PIC EO2512-3a Brightness Configuration Interface

According to the Brightness setting, program will scan the images in different degree of
brightness (range from -100 “dark” to +100 “bright”).

2.5.1.2.4 Contrast

j! Contrast:

PIC EO2512-4a Contrast Configuration Interface

According to the Contrast setting, program will scan the images in different degree of
contrast (range from -100 “less contrast” to +100 “great contrast”).

2.5.1.2.5 Paper Size

Faper Size: Scanner's Maximum j

B3 - 18.2%25.7Cm <
&5 -14.8x21.0Cm
A5 -21.0x14.8Cm

A4 - 21.0x29.7Cm
Legal - 8.5x14in.
Letter - 8.5x11in.

According to the Paper Size setting, program will capture the images in different size.

2.5.1.2.6 vThresholding (Support Black and White Image only)

vThresholding is an advanced imaging processing technology to automatically detect
the colour contrast to create the best quality B/W image without the need to rescan.

—wThresholding —* on  Off
- =5l 5
‘B
‘B U

PIC EO2512-6a vThresholding Configuration Interface (1)

This function is designed for Black and White image only. When “Simplex-BW” or
“Duplex-BW” mode is selected, vThresholding will be enabled automatically. User can
select “On” or “Off”.
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When vThresholding is “On”, 4 functions can be choosen:

L
- Dynamic vThresholding : Integrate the function of darken background
and pencil written paper vThresholdings, the image is scanned with optimized
quality.

%)
- Normal vThresholding a ! The image can be scanned with higher quality.

- Darken Background
background colour.

: Adjust colour contrast of scanned text on dark

- Pencil written paper ['%l
pencil text.

: Adjust colour contrast of light colour text such as

I | Attention | | When multiple color mode (Binary + Gray ; Binary + Color ; Gray +
Color ; Binary + Gray + Color) is selected, vThresholding is disabled automatically.

| | Attention ! | When vThresholding is “Off”, Auto Crop & Blank Page Removal
function will be disabled automatically.

—wThreshalding — Cn

5 Fr':'r'tl Rear | q/ll Front Rear | E é? :
o = -~
7! Contrast:  Auto, @ @
Auto Crop —— O & Off 'S E‘@ I E@

E- E;
i @ r 'a —Blank Page —— on & Off
Ml SOErESsIvE D Moise level
J—
—Ralativa Cram — s o oFF Lo ngh

PIC E02512-6b vThresholding Configuration Interface (2)
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2.5.1.2.7 Auto Crop

Auto Crop —— @ On " Off ——

Moffrial Aggressive

PIC EO2512-7a Auto Crop Configuration Interface

User can select to use this function or not. When “On” is selected, program does the
cropping process on the image. Two modes can be chosen: “Normal” and
“Aggressive”.

Aggressive Cropping can automatically straighten image and eliminate borders around
image during scanning.

I | Attention | | When multiple color mode (Binary + Gray ; Binary + Color ; Gray +
Color ; Binary + Gray + Color) is selected, Auto Crop is disabled automatically.

2.5.1.2.8 Rotation

Rotation v on O Off

IR AT

PIC EO0O2512-8a Rotation Configuration Interface

According to the Rotation setting, program will automatically rotate the image before
add-in. There are three modes of rotation: Rotate 90 degrees CCW, Flip and Rotate 90
degrees CW.

2.5.1.2.9 Deskew

Deskew
%
’7 EE = On Off

PIC EO2512-9a Deskew Configuration Interface

According to the Deskew setting, program do the deskew process on the image.

I | Attention | | When multiple color mode (Binary + Gray ; Binary + Color ; Gray +
Color ; Binary + Gray + Color) is selected, Deskew is disabled automatically.
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2.5.1.2.10 Blank Page Removal

Blank Page &~ On O Off
D Moise level
?
x Lo High

PIC EO0O2512-10a Blank Page Removal Configuration Interface

System will delete the blank page with blank page definition setting. User can select to
use this function or not. If “Off” is selected, “Noise level” will be disabled. If “On” is
selected, user can adjust the noise level ranges from low to high.

According to the noise level in configuration, program removes the blank page in the
document.

I | Attention | | When multiple color mode (Binary + Gray ; Binary + Color ; Gray +
Color ; Binary + Gray + Color) is selected, Blank Page Removal is disabled automatically.

I | Attention ! | If Blank Page is “On”, “Split / Merge Images functions” in Document
Setting will be automatically disabled.

2.5.1.2.11 Relative Crop

Relative Crop —+ On " off

PIC EO2512-11a Relative Crop Configuration Interface

System will crop the “first scanning image” according to the setting on template.
Click “On” of Relative Crop, “Setting” button will be enabled.
Click “Setting”, PIC E02512-11b will be displayed.
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The e-Filing Expert
x
Ik
Cancel
Browse Clear
PIC E02512-11b Select Template

Click “Browse” and select a template, and then select the cropping zone.
Click “OK” to confirm.

¥ Relative Crop

x|
L 0K
DEMO \/ITOVA
: L Cancel

Turning ast Informafion Inte Vital Assets

Browse Clear

PIC EO02512-11c Relative Crop Configuration Interface

As a result, the first page of each scanning batch will be cropped base on this setting.
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2.5.1.3 Image Scanning Adjustment Configuration

7

B Scanning Profile Configuration

?’ Profile:

General | color Setting |

Organize | Rename |

=1olx|

add Dot | messtal |

~Scanner Settings

& Mo Separation
 Separated by Blark Page

 Earcode.

" Every paper as ONE docurment

rvThresholding —& on € off
Qutput Calor: 4 Front | Rear | (84 Front | Rear | @4[From Rew 5 -
5 = m @
B Resoution:[200  +[ £+ erightness: 0] B contrast: At @l @l
e B @
sarc: oo [MRO®_ Fon CoF
Paper Size: Scanner's Maximum ¥ o @ o % et R On & off
Marmal Aogressive Naise level
—_—
Rotation —— on i« Off I:b* p ! e
Relative Crop " On & Off Lowe High
Deskew
@ o 1 0
‘%' i) | ’7\@ Fon  Cof
D settings
[~ Sphit Documernt

— Spiit / Marge Images

O Auto Split Images 9 a | Oéuty Merge Image
]

[ Em

£ L

Save Sawe and Exit

cancel

—Document Settings
— SEit Document

{* Mo Separation

" Barcode

" Separated by Blank Page

" Every paper a5 OME document

St £ Merge fmages

[w] Auto Split Images

E

¢ [H0 3 | b Auto Merge Images

PIC E02513-1

2.5.1.3.1 Split Document

— St Documeant

Image Scanning Adjustment Configuration Interface

&+ Mo Separation

" Separated by Blank Page

" Every paper a5 OMNE document

" BEarcode

PIC E02513-1a Split Document

- No Separation : Program will not separate the document.

Separated by Blank Page : Program will detect the scanning image. If the

image is a blank page, program will treat it as a separator and split it as
another document.

according to the number of paper.

| | Attention ! !

Every <number> paper as ONE document : Program will split the document

For simplex scanning, “Paper” means “per image”; for

duplex scanning, “Paper” means “two images”.
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\'ak 4
The e xpert

e-Filing E

2.5.1.3.2 Split / Merge Images

—Spiit S Merge Imeges

PIC EO2513-2a Split / Merge Images

Auto Split Images : Automatic split the images horizontally or vertically.

B select split Mode x|
Iz E=
oy | o=y

.i:?a. -ﬂl
P = =
é ,;'q, 4:, .c':l. ,cl
==
(0] Cancel

PIC E02513-2b Split Model Selection Interface

Select between 8 Split Modes. Top and bottom of each icon are showing the scanning
paper input direction (Follow the yellow arrow) and image process output respectively.

(This mode is mainly suitable for Book Scan.)
I | Attention | | Please reverse the image if the input scanning paper is face down.
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- Auto Merge Images : Automatic merge the images horizontally or vertically.
Only when “Duplex” scanning mode is selected, “Auto

Merge Images” will be enabled.

B select Merge Mode

| gE| mn| 6
B | B | 5| B
=
o | =2=| BE| 2=
¥ P, L ¢ " ¢
(0]4 Cancel

PIC E02513-2c Merge Model Selection Interface

Select between 8 Merge Modes. Top and bottom of each icon are showing the scanning
paper input direction (Follow the yellow arrow) and image process output respectively.

(This mode is mainly suitable for Book Scan.)

I | Attention | | Please reverse the image if the input scanning paper is face down.

I | Attention | | When “Simplex” scanning mode is selected, only “Auto Split Images”
is enabled. When “Duplex” scanning mode is selected, both “Auto Split Images” and
“Auto Merge Images” are enabled. But only either of them can be selected.

I | Attention | | When multiple color mode (Binary + Gray ; Binary + Color ; Gray +
Color ; Binary + Gray + Color) is selected, the whole part of Document Setting is

disabled automatically.
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The e-Filing Expert

2.5.1.4 Color Setting

EScanning Profile Configuration -|D ﬁl
:#’T.: Profile: ISimpIex-Bw j Organizel Rename | Add Delete | ResetAIII

General Color Setting |

—Calor Setting
—Garmma Correction —Color Balance (Color Images)
s
E % R(-100 - 100% Front 0] Rear 0=
el m E(-100 - 100) Front 0] Rear 0=
B(-100 - 100} Front 0] Rear 0=

[ Separate the Front settings with the Rear

—Color Filter (B&M [ Gray Images)

@ & Mone

TR
(el
B

Reset all | Copy Color Settings to All Profiles |

Save | Save and Exit | Cancel |

PIC EO2514-1 Color Setting Interface

2.5.1.4.1 Gamma Correction

—GEamma Carrection

e

Gamma: 1.0 =

PIC E0O2514-1a Gamma Correction Interface

According to the degree of gamma, ranges from 0.1 to 4.3, program will do the gamma
correction on scanning images.
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2.5.1.4.2 Color Balance

—Color Balance (Color Images)
[H—1

Ar -

O  R(-100 - 100) Front Dﬂ: Rear Dﬂ:
G{-100 - 100} Front Dﬂi Rear Dﬂi
B(-100 - 100} Front Dﬂi Rear Dﬂi

O Separate the Front settings with the Rear

PIC EO2514-2a Color Balance Interface

Program will scan the color images (front & rear) according to the adjustment of color
balance. User can select whether separate the Front settings with the Rear.

2.5.1.4.3 Color Filter

—Color Filter (B&\W f Gray Images)

G = Mone

R
G
B

PIC EO2514-3a Color Filter Interface

Program will do the color filter on binary or gray images according to the setting. User
can select the color filter by red, green or blue.
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-Filing Expert

2.6 Manual Enhancements Configuration

Manual Enhancement Process on Scanning Interface is according to this Configuration.

=: Manual Image Enhancement Configuration ] 5

Buttons for Image Enhancements

Bution 1 e = Ree] Button 2 |r|ip One-Time Enhancements
Button 3 IRDtate S0deqg CW j BUtOn 4 |pescreen

Functional Button Setting

Configuration for Image Enhancements:

h]
]?:' Descreen IMagazine j

| iA_. MR [High = Manual Enhancements Function Setting

ﬁ Watermark Watermark File: IC;\

Save I Cancel |

PIC EO26-1 Manual Enhancements Configuration Interface

Click “Options”> “Manual Enhancement”.
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The e-Filing Expert

2.6.1 One-Time Enhancements Functional Button Setting

Button 1 [SiErenehe Odeg CCW Button 2 Flip

=

Buttion 4 |Dascreen

Button 3 |Rotate Sodeg Cw

PIC EO261-1a One-Time Enhan ts Functional Button Setting

&
)il

ﬂl

L we e P! e Bt 1 18 e

PIC EO261-1b One-Time Enhancements Functional Button Setting

User can use four functional buttons on Scanning Interface to process one-time
enhancements to the image documents displayed. In this setting, user can set the
optional buttons to make the enhancement easier.

2.6.2 Manual Enhancements Function Setting

Configuration for Image Enhancements:

b
Efl:‘ Descreen IMagazine j
EA- Sharpening IHigh j
ﬁ Watermark Watermark File: IC;\ Browse |

Save I Cancel

PIC E0262-1 Manual Enhancements Function Setting Interface
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2.6.2.1 Descreen

+u
Efl:‘ Descreen Magazine j

Mewspaper

PIC EO2621-1 Descreen Setting Interface
For Descreen setting, 3 modes “Newspaper”, “Magazine” and “Leaflet” can be selected.
2.6.2.2 Sharpening

For easier enhancement, the functional button can be changed. E.g. Change “Descreen”
to “Sharpening” (Button 4).

Button 1 [potate o0deg CCW >|  Buttn 2 ey |
Button 3 Rotate 90deq CW j Button 4

PIC E0O2622-1a Sharpening Setting Interface (1)

Then, on the scanning interface, the button will also be changed Omatically. When
pressing this sharpening icon, all the images in the documentwill be sharpened in a
batch.

Profiles | ISimpIex—BW
3|

3 ; Fant‘ Fear | fi'% Fru:nnt| F.zar | qz-:Iant Fear |
A' |EDEI J_¢1D = IEI —l IScanners Mamml.J

PIC E02622-1b Sharpening button on Scannmg Interface

G | Dec. 11 | .

The degree of Sharpening can be adjusted, i.e. Light, Medium and High. Program will
sharpen the images according to this degree when pressing “Sharpening” button.

E A Sharpening High j
Light
Medium

PIC EO2622-1c Sharpening Setting Interface (2)
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The e-Filing Expert

2.6.2.3 Watermark

For easier enhancement, the button can be changed to Watermark.

BUESN 1 [Rotate o0deg COW > Button 2 |
BUtON 3 |Rntate 90deq CW j Bution 4 [[EYEneree
PIC E02623-1a Watermark Setting Interface (1)

Then, on the scanning interface, the button will also be changed autopaatically. When
pressing this watermark icon, watermark will be added on all the images in the
document in a batch.

Profiles | |5|mplex Bt ﬂ @ @ "_-f Frope| Rear | @ Frn:unt| Rear | Q_‘u W Rear |
j ﬁl B |2EI|:| ji:flﬂ IEI —I IScannersMammLJ

PIC E02623-1b Watermark button on Scannlng Interface

.| Doc. 141 .

Click “Browse” to open the watermark file.

ﬁ Watermark Watermark File: Ic;\ Browse I

PIC E02623-1c Browse Watermark File Interface

open 21x
Look in: I ky Documents j = IC:F Y
I" Ml Music
M';.-' Pickures

. b Nark.
&) testoo1

& testooz

File name: Iwatermark j Open I
Files of ype: | Image Files [* TIF; “TIFF: “JPG) = Cancel |
7

PIC E02623-1d Open Watermark File Interface
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The e-Filing Expert

2.6.3 Manual Enhancements

Image can be enhanced one by one.

Right click the Image 2 “Image Enhancements” and select the function.

& AV¥Scan E-filing System: Document1 TS

Fle Documert view Page Todls Spedal Opfions Help Powered by vitoScan
|T b profles | | Smplex-Bw =l @ o Front| Rear | @ Front| Rear | t‘; Wﬂl
g e | | A B st 28 2] Foaversean]
(s
R [H
ar
=

Post-Processing |

0@
&=

I. Bt is difficult for sirline scheduling managers to fime-tans their capacity 1o makch
demand end eontrol the costs st the kame time. Dircuss,

plznes. Disouss what are the fictoes and procss of this

E 3. Toe ailine industry of Asin is considersd o be oligopolistic in nswrs, Bowever,
depradent, Discuss.

4 =J it 2. Dengon Airlines has dropped sll Bocing 737 planes and replaced them by Airbus and
Baeing s change

e aistines in this region are mutsally
=
g8
Unda
Ej @ 4. Suppose you sre an sirpart Redo comments be
I
Edit Image
@ ey Rotate 90deg COW
ﬁ ﬁ Image Color Ratate 180deg COW
i { B oy oowm o Rotate 90deg CW
ﬂ that significs the growthia | proerties Y
Descreen
Sharpening
E}E @% ﬁ 6. The Hong Kong Intemational Alrport s ane of the busicst sirports in Wifatermark.

e the causes of and flight delays? If you wers the
‘actioms would you tale b solve the preblems?

- Theend -

1</ <] page 11 sl : ' Page File Size:37K bytes
@ start| & awscan E-filng System: .. | 1 uniciled - Paint | @ Az assam
PIC EO0263-1 Manual Enhancements on Scanning Interface

Rotate 90deg CCw
Rotate 180deq COW
Raotate 90deg CW
Descreen
Sharpening

Wy atermark

PIC E0263-2 Manual Enhancements Selection
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The e-Filing Expert

2.7 Save Documents

There are two types of saving method allowed.

L=
- Document Ulul 11 ulul

a| g

=

Document No. Display
MNaormal Mode |E‘.ah:h Mgdel

e = R

Path: |gs\AdministraU3r\M\; Docwu ments| Bromwse |
T N L T arp——
. — . dérnand mad corvial] ihe cogs 01 the sae e Disuss
Eilenarme: |A\r|s ian | Haming |
Files: Mame |size  |LastmodifedDate | 7 Boeg hess e et o oo e gt

Document Information Entry

Faormat:

Save Setting |
= il == B R )
|

Page Display

PIC EO27-1 Saving Interface

Click J or <HotKey V Key> to save documents one by one.

After clicking the button, you can save the documents through “Save” interface.

a
=

Save to File : Save the scanned files to your computer independently.

— 1 E-mail Files : E-mail the scanned files with default mailing system.

User can save the documents to File or E-mail the document.
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Farmat: Multiple Page TIFF j

Sinile F‘aie TIFF

JPEG

POF

BMP

GIF

o

High Compressed PDF-Acrobat 6.0

PIC EO27-2 Save Format Selection

AVScan provides different formats for saving documents.

AVScan provides a built-in high-compressed PDF (HCPDF) conversion technology
that can compress a colour document file to the same size as its monochrome
equivalent, allowing more versatile handling and network transmission.

DjVu is the premier open platform for managing, storing and exchanging colour
documents without sacrificing visual quality, text resolution, and legibility. With
AVScan, unlimited pages of scanned documents can be converted into DjVu format in a
second. This flexibility reduces the cost and consumption of file storage and bandwidth
for images.

¥ Save Setting X
: TIFF Compression || IPEG Cofripression | High Carmpress POF 4 | ¥
Black and White ICCITT Group 4 (2d) Fax j
2 bit Gray: |PeG =
24 bit Colar: | PEG =
(0] 4 | Cancel |

PIC EO27-3a Save Setting Interface

<!lAttention!! The image with JPEG Compression cannot be opened by “Windows
Picture and Fax Viewer” in Windows XP, but it is supported by “Imaging” in Windows
2000.>

AVScan — User Manual Page 43 of 59



\/ITOVA

The e-Filing Expert

=:| Save Setting EI
JPEG Compression | High Compress POF i Jie
Image Type: IStandard j
K Cancel

PIC EO27-3b Save Setting Interface

Save Setting configures the TIFF compression format, JPEG compression ratio, High
Compress PDF format and DjVu.
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2.7.1 Save to File — Save the scanned files to your computer

independently

=]

Select “Save Document to File System == " and the PIC of “Normal Mode” will be

shown as below.

Marmal Mode |Eab:h Mode |

Path: |C iy | Browse |
Eilename: |f-‘«ﬁ.fisin:|r'| | Harming |
Files: Marre | Size | Last Modified Date |
Format; Multiple Page TIFF j
Save Setting

PIC EO271-1 Save to File — Normal Mode Interface

Each document is saved as different name individually.

Path Destination Folder
Filename Enter the File Name of the Document
Files List the files_ in Destination Folder. _
Select the files to do the replacement or save as a new file.
The output format as Single-Page TIFF, Multiple Page TIFF, JPEG,
PDF, BMP, GIF, DJVU and High Compressed PDF-Acrobat 6.0 - If
Format multi-page of document saves as Single-Page TIFF or JPEG

format, the default file name is IMAGEXXX.YYY (XXX presents as
page no., YYY presents as output format.)

Automatic Naming

If multi-page of document saves as Single-Page TIFF or JPEG

(Automatic format, the default file name is automatic generate as
Generate File IMAGEXXX.YYY (XXX presents as page no., YYY presents as
Name) output format.)

AVScan — User Manual
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Besides “Normal Mode”, “Batch Mode” can also be selected and the PIC will be
shown as below.

Mormal Mode  Batch Mode |

Path: |C M | Browse |
Format: IMuItipIe Page TIFF j
Docurment: Prafi: | Avisian |
Suiffix. | |
Starting Mo, : 1 .
File:
Display Digit: E :
Starting Mo, : E -
Filenarne: Aviziond01, TIF, Reset
Avisiondo2, TIF,
Ayvisiond03. TIF, ... Save Setting

PIC EO271-2 Save to File — Batch Mode Interface

AVScan support “Automatic Naming” function, which can save all the documents with
series format.
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2.7.2 E-Mail File

Click \_‘ or <HotKey M Key=> to E-mail the documents directly. The PIC of “Normal
Mode” will be shown as below.

Morimal Mode | Batch Mode I

Eilename: |ﬁvisi|:|r‘| | arming |
Farmat: IMuItipIe Page TIFF j
Email Setting

& Send Email through Windows Messaging AP
! Send Email through Latus Notes

Save Sefting

PIC EO272-1 E-Mail File — Normal Mode Interface
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Besides “Normal Mode”, “Batch Mode” can also be selected and the PIC will be shown as
below.

Mormal Mode  Batch Mode |

Farmat: IMuItipIe Page TIFF j
Document: -
Prefix: |f-w|5||:|r‘| |
SLffis: | |
Display Digit: £ =
Starting Mo. : L :
et Display Digit: g :
Starting Mo, 5 =
Email Setting: | & cond Ermail through Windows Messaging
€ Send Email through Lotus RHotes
. . &wision001, TIF, .
Filename: . ieion002, TIF. Avisionona, Reset | Save Setting

PIC EO272-2 E-Mail File — Batch Mode Interface

In Batch Mode, “Automatic Naming” function is supported, which can save all the
documents with series format.

Click EI after entering the document information. Program will run OS default
mailing system (E.g. Outlook Express etc.) and mail it as attached files.
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irewressoge ———RIoT®
J File Edit Wiew Insert Format Tools  Message Help |
(S(% @@ -ja v
Send ik Copy.  Faste  Undo Check  Spelling

58 To |

R e |

Subject: I

Attach: I@ Lovison001001 f (277 KB)

1—
=
T—

A= E|e zoa

a

PIC E0O272-3 E-Mail Interface
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2.8 Setting
Click “Options” = “Setting”.

2.8.1 Auto Crop Index

=101 x|
| AutD Crop Indes | Payment Counting I Scanner Model | Energy Saving |
Automatic Feeder |
MormaliD} Aggressive (307
Colar (Front) J
15
Color{Rear) J
20
BEMW Gy (Front) J
1]
BEM fGrey(Rear) J
1]
Ik Cancel

PIC EO281-1 Auto Crop Index Setting Interface

“Normal” and “Aggressive” are the modes of Auto Crop.
In the above setting interface, user can adjust the auto crop index for scanning images
by feeder scanner or flatbed scanner.
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2.8.2 Payment Counting

=101 %]

Auto Crop Index  Payment Counting | Scanner Model | Energy Saving |

¥ Enable Payment Courting

Charge per Page:

$ |1.|:| 3:

Ik Cancel

PIC E0282-1 Payment Counting Setting Interface

This function is designed for counting the charge of each scanning page. User can
enable this function and key in the cost of each page scanned.
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2.8.3 Scanner Model

Auto Crop Index | Payment Counting : Scanner Model | Energy Saving |

Certification Date: 2008,06,04

=101 %]

Certified Scanners

| -

W av121
a1z
[ avz2n
4 AV220G
[N AV222
4 Av220C2
Favzioce
¥ Av3800
FHaw37an

Current Scanner:

Model Mame: ANV1Z22

[

Atributes |

Ik

Cancel

PI1C E0283-1 Scanners Model Interface

This interface shows what scanner models can be supported by AVScan.
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2.8.4 Energy Saving

=101 %]

Autn Crop Index | Payrment Counting | Scanner Model

¥ Enable Energy Saving after

15 =~ mins.

Ik Cancel

PIC E0284-1 Energy Saving Interface

Scanner will sleep automatically after quitting AVScan for 15 minutes (User can adjust
the time by preference). This function can help to save the energy of scanner.
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2.9 Language

Click “Options” - “Language”.

%' Select Language of User Interfac x|

Please select the language of the user interfaca:

 Traditional Chinase
 Simplified Chinese
i~ German

" Korean

" French

i~ Czech

" Portuguese

Save Cancel

PIC E029-1 Language Setting Interface

This function is designed for changing the language of the scanning interface.
8 languages (English, Traditional Chinese, Simplified Chinese, German, Korean, French,
Czech & Portuguese) are supported by AVScan.
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3. Hot Key
Hot Key Hot Key Function
1 Single Page Display Mode
2 Double Page Display Mode
4 Four Page Display Mode
8 Eight Page Display Mode
Home First Page
PageUp Pervious Page
PageDown Next Page
End Last Page
Ctrl+Home First Document

Ctrl+PageUp

Pervious Document

Ctrl+PageDown

Next Document

Ctrl+End

Last Document

Scan

Stop Scan

+|oln

Zoom In

Zoom Out

Best Fit

Fit to Width

Fit to Height

Edit Image

Edit Field

New Document

Save

ol<|Zz|mmT|S|w|

Delete Document

n
o
Q
(2]
D

Confirm the use of functional button

m
n
O

Cancel the action
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The e-Filing Expert

4. Trouble Shooting

Question: Why is the image not cropped even though Auto Crop is enabled in profile

setting?

_"l_ Scanning Profile Configuration

lE#, Profile:

General | calor Setting |

Organize | Rename |

=10l |

Add | Delete | Reset all |

—Scanner Settings

Output Colar: '-" Front — Rear | @'j Frontl Rear | ‘1. Fru:nntl Rear |
Resolution:lznn vlf} Brightness:
Source: I.i\uh:nmatic At Crop S ® i
Tl
Paper Size: IScanner's Maximurm 9 £ E]

Marmal Aggressive

—wThreshalding —& on © Off

iy f2
(:. ‘E r JE
S
‘Ba U

}Iank Page — 1 On & Off

Moise level

" Every paper as OMNE document

) Barcade

Rotation ——" on f* off ! |
Relative Crop " On & Off v High
& chl A3

—Document Settings
— St Doctmearnt Skt / Marge Images

&+ Mo Separation

[
" Separated by Blank Page [ Auta Split Images £ y | O Autn Merge Image F'—TI!{

Save

Save and Exit

Cancel

PIC EO4-1

Profile Setting
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--.LEAYScnn E-filing System: Document] - E'lil
File Document View Page Tools ESpecial Options Help Powered by Vitoscan

N b =l [ | rrontRear | 65 Front| Rear | @4 Front| rear |
| 1 | | (AR Bl Sl ] 2 [Bemers e 2]
| =

f

E]=]x
ara

|

Post-Processing |

3

)

-
1]

C

&l
=

4
T

ik
x
& H

i,
58 e

“Bla/ M

a:

K| <] Page 1713 1 Page1 File Size:1 00k hyles
PIC EO4-2 Image without Cropping

Answer: Auto Crop function is not performed well in PIC EO4-2. User should calibrate
the scanner in order to get the background color of scanner for processing Auto Crop
function effectively.

To do Scanner Calibration:

1. Click “Options” - “Scanner Calibration”.

2. Feed an A5 paper with the shorter side at the bottom to the scanner.

3. Press “Scan” button.
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x|
Instruction: Please feed a AS paper with the shorter side at the bottorn (as

showen in the figure) o the scanner, and press "Scan" for starting calibration
process,

Scan I Cancel |

PIC EO4-3 Scanner Calibration (1)

4. Feed the A5 paper again, and then press “OK”.

x|

@ Flease feed the paper again and press "OK",

PIC EO4-4 Scanner Calibration (2)

5. Press “OK, after calibration is completed.

nformation Y

@ alibration is Completed!

PIC EO4-5 Complete Calibration

6. Scan the document again after calibration, a good image with auto crop is resulted.
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-SAYScnn E-filing System: Document] - E'lil
File Document View Page Tools ESpecial Options Help Powered by Vitoscan

. b Profiles ||5i"ﬂP|'?><-C0|Dr =l @@ 7 | Front Rear @ Front| Rear | 1“ Front| Rearl
_.l r%]l . |Dec. 1/1 .‘_::| .‘_::l [ﬁ E“:‘ 200 * 0 jli!lo—ill IScannBr‘s Mairm. ™

| = |

2
E.'EBH
Q|
=

FI
v
g8 | BB
5 W
@D
5|0 e

K| <] Page 5/53 01 - - Pages File Size:79k hytes
PIC EO4-6 Scan Result after Calibration

Contact Us.

Thank you for chosen AVScan Capture Software - International.

Feel free to request new features or suggest modifications to existing features and let us
know your feedback.

For general, please call 852-27701080 (Hong Kong) or 86-755-25862351 (PRC); or
visit http://www.vitova.com.
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